


About SWF 'n Slide Pro

Thank you for choosing SWF 'n Slide Pro. SWF 'n Slide Pro is an extremely easy program to take any 
digital images and create a stunning slide show in minutes to share with family and friends. 

SWF 'n Slide Pro creates slide shows to be played with the Macromedia Flash Player. The latest Flash 
Player can be downloaded for free from Macromedia's web site at http://www.macromedia.com. 

http://www.macromedia.com/


System Requirements

●     Power PC based Macintosh or greater 
●     Macintosh OS X or higher 
●     64 MB of RAM 
●     50 MB of available hard disk space 
●     QuickTime 4.0 

The latest QuickTime can be downloaded for free from Apple's QuickTime website at http://www.
quicktime.com 

http://www.quicktime.com/
http://www.quicktime.com/


Getting Started

Below is a brief description and steps to start you to create your own slide shows with SWF 'n Slide. 

To start using SWF 'n Slide you need to choose if you want to create a new slideshow or open up an 
existing slide show.
Create a new slide show: This option will create a brand new slide show of the chosen Slide Show 
Type.
Create a new slide show from folder: This option will create a brand new slide show from a folder of 
images.
Open an existing slide show: Opens an existing SWF 'n Slide Project file (.sns). You can choose from 
the recent history list or click the "Browse.." button to select a Project file from disk.

Choose the Slide Show Type



If you choose to create a new slide show, you must also choose the type of slide show you wish to create 
from the "Slide Show Type" drop down list. 



Preview Slide Show

Preview Slide Show 

Choose "Preview" from the "Slide Show" menu or toolbar to preview the slide show output. A 
temporary SWF file will be generated and played in a window for viewing. 



Publish/Export Slide Show

When you're ready to deliver your slide show to an audience, you must publish or export the slide show 
to another format for playback. 

Export 

Exporting the slide show will produce a Flash Movie (SWF) file. SWF movie files can be played in the 
Flash Player or any browser that has the Flash Player plugin installed. To export the slide show, select 
"Export" from the "File" menu or the toolbar. 

Publish 

The "Publish" command gives you additional formats to deliver the slide show.

●     Flash Movie - a Flash Movie (SWF) file. 
●     HTML - a HTML document to display the Flash Movie file. 
●     Macintosh Projector - a self executable Flash movie to run on Macintosh compatible computers 

without the need for the Flash Player to be installed on the users computer. 
●     Windows Projetor - a self executable Flash movie to run on Microsoft Windows compatible 

computers without the need for the Flash Player to be installed on the users computer. 
●     QuickTime - a QuickTime movie file with the Flash movie inserted onto a separate QuickTime 

track. 

To publish the slide show, select "Publish" from the "File" menu. Before publishing the first time, you 
should choose "Publish Settings..." from the "File menu to choose which formats to publish and their 
settings. 

Publish Settings 

The "Publish Settings" allow you to specify which formats to publish and their settings. 



 
OK: Save the current publish settings and close the Publish Settings dialog box. 
Cancel: Close the Publish Settings dialog box without saving the current settings. 
Publish: Save the current publish settings and publish the specified formats. 

Formats 



 

Output To: The path where all published files will be saved to on disk. Click the "Browse" button to 
specify a different location. 
Check the boxes for the format "Types" you want to publish and enter the "Filename" for the file.
Use default names: Automatically changes the base filename to match the filename of the currently 
loaded SWF 'n Slide Project file (.sns)

HTML 

 



Width: The display width of the Flash movie.
Height: The display height of the Flash movie.
Dimensions: Choose if the dimensions should match the actual dimensions of the Flash movie, or use 
your own custom size.

Background Color: The background color of the HTML file.

Playback: Allows you to set options to control the movie's playback and features 

●     "Paused at start" pauses the movie until a user click a button in the movie or chooses Play from 
the shortcut menu. 

●     "Loop" repeats the movie when it reaches the last frame. 
●     "Display Menu" displays a shortcut menu when the user right-clicks (Control + click) the movie. 
●     "Device Font" will substitute anti-aliased system fonts for fonts not installed on the user's 

system. Using device fonts increases the legibility of type at small sizes and can decrease the 
movie's file size. 

Quality: Set the playback quality to determine the trade-off between processing time and applying anti-
aliasing to smooth each frame before it is rendered on the viewer's screen. 

●     "Low" favors playback speed over appearance and does not use anti-aliasing. 
●     "Auto Low" emphasizes speed at first but improves appearance whenever possible. Playback 

begins with anti-aliasing turned off. If the Flash Player detects that the processor can handle it, 
anti-aliasing is turned on. 

●     "Auto High" emphasizes playback speed and appearance equally at first but sacrifices 
appearance for playback speed if necessary. Playback begins with anti-aliasing turned on. If the 
actual frame rate drops below the specified frame rate, anti-aliasing is turned off to improve 
playback speed. 

●     "Medium" applies some anti-aliasing, but does not smooth bitmaps. It produces a better quality 
than the Low settings, but lower quality that the High settings. 

●     "High" favors appearance over playback speed and always uses anti-aliasing. If the movie does 
not contain animation, bitmaps are smoothed. If the movie has animation, bitmaps are not 
smoothed. 

●     "Best" provides the best display quality and does not consider playback speed. All output is anti-
aliased and bitmaps are always smoothed. 

Window Mode: Allows you to set options for transparency, positioning, and layering of the Flash 
movie. This option is not compatible with all browsers. 

●     "Window" plays a Flash Player movie in its own rectangular window on a web page, for the 
fastest animation. 

●     "Opaque Windowless" moves elements behind Flash movies to prevent them from showing 



through 
●     "Transparent Windowless" shows the background of the HTML page on which the movie is 

embedded through all transparent areas of the movie, but may slow animation. 

HTML Alignment: Allows you to position the Flash movie window within the browser window. 

●     "Default" centers the movie in the browser window and crops edges if the browser window is 
smaller than the movie. 

●     "Left, Right, Top, Bottom" aligns the movie along the corresponding edge of the browser 
window and crops the remaining three sides as needed. 

Scale: Allows you to place the movie within specified boundaries. 

●     "Default (Show All)" displays the entire movie in the specified area without disortion while 
maintaining the original aspect ratio of the movie. 

●     "No Border" scales the movie to fill the specified area and keeps the movie's original aspect 
ratio without distortion and crops if needed. 

●     "Exact Fit" displays the entire movie in the specified area without preserving the original aspect 
ratio, which may cause distortion. 

Flash Alignment: Allows you to set how the movie is placed within the movie window and how it is 
cropped, if necessary. 

●     "Left, Center, Right" are used for horizontal alignment. 
●     "Top, Center, Bottom" are used for vertical alignment. 

QuickTime 



 

Width: The width of the QuickTime movie.
Height: The height of the QuickTime movie.
Match Movie: If checked, the dimensions will automatically match the actual size of the slide show 
document.

Alpha: Allows you to control the transparency mode of the Flash track in the QuickTime movie without 
affecting any alpha settings in the Flash movie. 

●      None: Makes the Flash Track opaque.
●      Auto-Transparency: Makes the Flash Track transparent if it is on top of any other tracks, but 

opaque if it is the bottom or only track in the movie.

Controller: Allows you to specify the type of QuickTime Controller used to play the movie. 

●      None does not add a QuickTime controller. 
●      Standard adds the standard QuickTime movie controller to the movie. 

Playback: Option allows you to control how the QuickTime movie plays. 

●      Loop repeats the movie when it reaches the last frame. 
●      Paused at start pauses the movie until a user clicks a button in the movie or chooses Play from 

the shortcut menu. 

Flatten (Make self-contained): Combines the resource fork and data fork data. Use this option if you 
want to use the QuickTime movie file between a Macintosh and Windows PC. 

Projector 



Fullscreen: If checked, the Projector will automatically play at full screen. 
Allow Scale: If checked, the Projector can be resized.
Show Menu: If checked, the standard Flash contextual menu wil be enabled.

Expire On: The date after which the Projector file will no longer play.
Message: The message to display when trying to launch the Projector file after the Expiration date. 



Save/Load Slide Show

Saving 

You can save the settings for your slide show to a SWF 'n Slide Project file (.sns) by choosing "Save 
Project" or "Save Project As..." from the "File" menu or toolbar. To overwrite the current slide show 
project file, choose "Save Project". To save the file in a different location or with a different name, 
choose "Save Project As...". 

Please note that the project file does not save any images or sounds used in the slide show into the 
project file. If you move or delete any of the files used in the slide show, SWF 'n Slide will not be able 
to re-create the slide show. 

Loading 

You can load and previously saved SWF 'n Slide Project file (.sns) by choosing "Open Project" from 
the "File" menu or toolbar. 



Gettings Started

Below is a brief description and steps to start you to create a Simple Slide Show with SWF 'n Slide. 

Add slides to the slide show 
To start using SWF 'n Slide you need to add slides to the slide show. You can add slides by browsing for 
images by selecting "Insert Slide..." from the "Slide Show" menu or dragging and dropping image files 
onto the slide list window. Click here for more information on Adding/Removing slides. 

Customize the slide show 
Use the "Slide Show Properties" dialog box to customize various properties of the slide show including 
size, sound, and text. You may bring up the "Slide Show Properties" dialog box at any time by choosing 
"Slide Show Properties..." from the Slide Show menu or the toolbar. 

Customize the slides 
After your have added your slides to the slide show, you may customize them by selecting them from the 
slide list window and opening up the "Slide Properties" dialog box. Use the "Slide Properties" dialog 



box to customize various properties for individual slides including, size, sound, text, timing, and transition 
effects. You may bring up the "Slide Properties" dialog box at any time by choosing "Slide 
Properties..." from the Slide Show menu or the toolbar. 

Preview the slide show 
When you are ready to see what your slide show will look like, you may preview the slide show by 
selecting "Preview Slide Show" from the "Slide Show" menu or the toolbar. Click here for more 
information on previewing the slide show. 

Export/Publish the slide show 
When you're ready to deliver your slide show to an audience, export or publish the slide show by 
choosing "Export..." or "Publish from the "File menu. Click here for more information on publishing 
the slide show. 

Save the slide show settings 
You can save the settings for your slide show at any time by going to the File menu and choose "Save" or 
"Save As...". A SWF 'n Slide Project File (.sns) will be saved to disk. You can then open up the project 
file by goin to the File menu and choose "Open" to continue working on your slide show. 



Add/Remove Slides

Adding Slides 

Slides may be added to the slide show by: 

●     Selecting "Insert Slide..." from the "Slide Show" menu. 
●     Selecting "Insert Folder..." from the "Slide Show" menu. 
●     Clicking on the "Insert Slide" button from the toolbar. 
●     Drag and drop an image file(s) onto the Slide list window. 

Supported image file types include Bitmap (bmp), GIF, JPEG, PICT, PNG, Photoshop (psd), TIFF, and 
Targa (tga).

Blank slides may be added to the slide show by: 

●     Selecting "Insert Blank Slide" from the "Slide Show" menu. 



●     Selecting "Insert Blank Slide" from the toolbar. 

New slides will be inserted after the last currently selected slide. If no slides are currently selected, new 
slides will be inserted at the beginning. 

Removing Slides 

Select the the slides from the list you want to remove. You may select a range of slides by holding down 
the Shift key while clicking on the slides in the list, or multiple individual slides by holding the down 
Command key. Select "Delete Slide(s)" from the "Slide Show" menu or the toolbar to remove the 
selected slides. 



Slide Show Properties - General

The General tab allows you to customize the attributes of the Flash movie and general appearance of the 
slide show. 

 

Slide Show Document 



 

Document: Choose from various pre-defined standard dimensions for the slideshow, or choose Custom 
to enter in your own size. Note that larger sizes may result in decreased performance on slower 
computers.
W: The width of the slide show document. If Custom is chosen from the Document drop down list, this 
field will be enabled for you to enter in your own value, otherwise, it will be disabled automatically be 
filled in with the pre-defined value.
H: The height of the slide show document. If Custom is chosen from the Document dro down list, this 
field will be enabled for you to enter in your own value, otherwise, it will be disabled automatically be 
filled in with the pre-defined value.

Frame Rate: The number of frames per second to play the slide show at. Higher frame rates will result 
in smoother animation, but may result in decreased performance on slower computers. Common frame 
rates are as follows: 

●     Web - 8 to 15 fps 
●     Standard Motion Picture - 24 fps 
●     NTSC - 29.97 fps 
●     PAL - 25 fps 

Bg Color: Click to choose the color to display in the background of the slide show document.
Bg Image: Check this option if you would like to display an image in the background. If checked, the 
Settings.. button will be enabled for you to set the properties for the background image.

Auto Time: You can choose to have the slideshow to be automatically timed to the duration of the audio 
file used in the slide show or to a specified amount of time.

Compress: If checked, the exported .swf file will be compressed. To playback compressed .swf files, 
the viewer will need version 6 or higher of the Flash Player.
Protect: If checked, Macromedia's Flash Authoring Tool will not be able to import the export .swf file.
Disable Printing: If checked, the Print option from the Flash player will be disabled. 



Standard Slide Show 

 

Image View: These bounds are the bounds within the Slide Show Document to which images are 
automatically scaled and fitted to if Auto Align or Scale to fit are enabled in the "Media" tab. 

Match Document: If checked, the bounds will automatically be filled in to match the size of the slide 
show document.

The "Image View" bounds are used to help size and align the slide images.If you want the slides to fill 
the entire document, you should set the values to match the "Width" and "Height" values.If for example 
you would like to leave 30 pixels to be blank at the top (for captions, controls, etc), you would set the 
Top Image View to be 30. If for example you would like to leave 30 pixels to be blank at the bottom, 
you would need to set the Bottom Image View to the "Height" of the slide show minus 30 (ie. 240-30 = 
210).

Border 

 

A border may be added to be displayed on top of everything. Select the border type from the "Type" 
drop down list. 

●     "None" will not add a border to the slide show. 
●     "Color Flat" will add a solid color border. 
●     "Color Bevel" will add a color border with raised edges. 
●     "Color Hilite" will add a color border with a light spot. 
●     "Metal" will add a metal border. 
●     "Pattern" will add a border with a specified pattern from a list. You may add your own patterns 

to the program by adding image files to the "Frames" folder in the programs folder. 
●     "Custom Pattern" will add a border with a specified pattern from anywhere on disk. 



You may set the size of each side of the border by entering in appropriate values for the left, right, top, 
and bottom. 



Slide Show Properties - SWF

The SWF tab allows you to customize the playback of the slide show. 

 

Movie Start Action 

The "Movie Start Action" option allows you to choose an action when the slide show starts. 



 

Play Automatically: Start playing the slide show as soon as it is loaded into the Macromedia Flash 
Player. 
Play after Pause: Start playing the slide show after the desired number of seconds has elapsed. 
Stop on First Frame: Load the slide show into the Macromedia Flash Player and then stop until there is 
user interaction to continue playing the slide show. One method to resume playback when this option is 
chosen is to target the slide show SWF from an external SWF and resume playback via actionscript. You 
may also right click ( Control + click) to bring up the Flash popup menu and select "Play" to resume 
playback of the slide show. 

Preload: Allows you to add a preloader to the slide show. If this option is chosen, a progress bar will be 
displayed showing the percentage of the slide show that has been downloaded/loaded into the 
Macromedia Flash Player. When the desired percentage of the SWF file has been loaded, playback of 
the slide show will begin. This option is helpful to allow smoother playback on slower internet 
connections. Click the Settings.. button to customize the preloader.

Loop 

The "Loop" option allows you to choose the number of consecutive times the slide show will play. 

 

Play Once: Play the entire slide show and stop after the last slide is reached. 
Loop: Repeat the slide show the desired number of times and then stop. 
Play Forever: Continually play the entire slide show. 



Mouse Click Action 

The "Mouse Click Action" option allows you to specify an action to take when the user mouse clicks 
the Macromedia Flash Player while the slide show is playing. 

Action: The action to take when the user mouse clicks on the slide show. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.

Movie End Action 



The "Movie End Action" option allows you to specify an action to take when the slide show ends. 

Action: The action to take when the slide show ends. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)
●      Unload Slide Show: Cause the Flash Player to unload the slide show from the player when it 

ends. This option causes the SWF file to be removed from RAM. 

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Preloader Settings

The Preloader Settings dialog allows you change the settings for a preloader.

 

Preloader 

Preload %: The percentage of the file you wish to preload before attempting to playback the swf file.
Message: Any message you wish to display while the file is being preloaded.
Font: The font to use for the Preload % and Message.
Font Color: The color to use for the Preload % and Message text.

Import Preloader from SWF, Lock & Load

Import...: Allows you to choose a SWF, Lock & Load project file (.lkl) to import.
Edit...: Launches SWF, Lock & Load to allow you to further edit the SWF, Lock & Load project file.
Remove: Removes the current SWF, Lock & Load project file chosen for import.

http://www.verticalmoon.com/products/swflockload


Pop-Up Settings

The Pop-Up Settings dialog allows you to customize the pop-up window

 

W: The width of the pop up window.
H: The height of the pop up window.
X: The horizontal position to display the pop up window.
Y: The vertical position to display the pop up window.

Resizable: Specifies whether or not the user may resize the popup window.
Scrollbar: Specifies whether horizontal and vertical scrollbars should be added to the pop up winodw. 
Most browsers will display the scrollbars only when needed to view content beyond the window area.
Toolbar: Specifies whether the toolbar should be shown. The toolbar contains the browser's navigation 
buttons such as Back, Forward, Reload, and Home.
Directory Bar: Specifies whether the directory bar should be shown. 
Status Bar: Specifies whether the status bar should be shown. The status bar area contains the security 
inidicator and status bar messages.
Location Bar: Specifies whether the location bar should be shown. The location bar is where the URL 
of the current page is shown.
Menu Bar: Specifies whether the menu bar should be shown. The menu bar contains the browser's 
menus such as File, Edit, and View.



Slide Show Properties - Sound

The Sound tab allows you to add a sound to play during the playback of the slide show. 

 

Check the "Play Sound" if you want to add a sound. Click the "Browse..." button to select a sound file 
to use. 

Properties 



 

Properties for the chosen sound will be displayed here. 

Format: The type of audio file. 
Duration: The duration length of the audio.
Sample Rate: The number of times an audio signal is sampled when it is recorded digitally. The more 
samples per second, the more accurate the digital representation of the sound. CD-quality audio has a 
sample rate of 44,100 Hz (44.1 kHz). FM radio quality audio has a sample rate of 22,050 Hz (22.05 
kHz).
Channels: Mono for 1 channel, Stereo for 2 channels. 
Sample Size: The number of bits per sample. The more bits per sample, the more accurate the digital 
representation of the sound. CD-quality audio has uses 16 bits per sample. 

Quality 

 

Quality: A list of predetermined compression settings. You may choose a preset from the list or choose 
"Custom" to choose your own settings. The presets are only recommended settings. Result may vary 
depending on the type of audio being used and it's original quality. 
Sample Rate: The number of samples per second. Higher sample rates will result in higher quality but 
larger file sizes. 
Bit Rate: The number of bits per seconds. Higher bit rates will result in higher quality but larger files 
sizes. 
Stereo: If checked the sound will be encoded in stereo, otherwise mono. Stereo will result in larger file 



sizes than Mono. 

Playback 

 

Lead-In: The number of seconds to wait before playing the sound. 
Use entire sound: If checked, the duration will be disabled and automatically filled with the actual 
duration of the source sound file. 
Duration: The number of seconds to use from the sound. The value should not exceed the actual 
duration of the sound file. This field will be filled in automatically and disabled if the "Use entire 
sound" option is checked. 
Play: Choose if you would like the audio to loop. 

●      Play Once: Play the audio once and stop.
●      Play Forever: Continually repeat the audio.
●      Loop: Repeate the audio a specified number of times and then stop.

Stream: If checked, the audio will stream in. 



Slide Show Properties - Controls

The Controls tab allows you to add playback and audio controls to the slide show. 

 

Slide Show Controls 



 

Slide Show Controls: If checked, a set of playback controls will be added to the slide show. The various 
types of control sets can include Jump to First Slide, Jump to Previous Slide, Jump to Next Slide, Jump 
to Last Slide, and Play/Pause buttons for controlling the playback of the slide show. 

Type: This drop down list will contain all of the control sets you can choose from. A preview of the 
chosen control set will be displayed below.

Alignment: Choose to have the controls automatically aligned within the slide show document, or 
choose "Custom" to enter your own position.
X: The horiztonal position of the controls relative to the left slide of the slide show. 
Y: The vertical position of the controls relative to the top side of the slide show. 

W: The display width of the controls.
H: The display height of the controls.

Mute Control 

 

Mute Control: If checked, a mute control will be added to the slide show.

Type: This drop down list will contain all of the mute control you can choose from. A preview of the 
chosen mute control will be displayed below.



Alignment: Choose to have the mute control automatically aligned within the slide show document, or 
choose "Custom" to enter your own position.
X: The horiztonal position of the mute control relative to the left slide of the slide show. 
Y: The vertical position of the mute control relative to the top side of the slide show. 

W: The display width of the mute control.
H: The display height of the mute control. 



Slide Properties - Media

The Media tab allows you to set how the media will be displayed. 

 

Media 



 

Path: Displays the current full path to the source file for the media.
Dimensions: The dimensions of the source media (if any) in pixels.

Browse: Click the Browse button to choose a new source file for the media.
Remove: Removes the current source file for this slide. After removal, the slide will automatically 
become a Blank Slide.

Output 

 

X: The horizontal position of the media relative to the left side of the slide show document. 
Y: The vertical position of the media relative to the top side of the slide show document.
Align Image: If checked, the media can be automatically positioned within the slide show. If checked, 
the 6 alignment buttons will be enabled. You can choose from the 3 horizontal alignment positions (left/
center/right) and from the 3 vertical alignment positions (top/center/bottom).

W: The output width of the media in pixels.
H: The output height of the media in pixels.
Scale To Fit: If checked, the output size of the media will be stretched to fit the dimensions of the slide 
show. The output dimensions will automatically be filled in, and cannot be changed unless unchecked 
again.
Keep Aspect Ratio: If checked, the media will retain it's original proportions when changing the output 
width or height of the media.

Rotate: The angle at which to display the the media in the page.



Export: The output format for the media. If Jpeg or Jpeg w/ Alpha Channel is chosen, you will need to 
set the Quality. The Quality can be a value ranging from 1 to 100 where 100 will result in the highest 
image quality and the largest file sizes, while a value of 1 will result in the lowest quality and smallest 
file sizes. 

●     Jpeg will compress the images to jpeg.
●     Jpeg w/ Alpha Channel will compress the images to jpeg with an Alpha Channel (Tranparency 

Data).
●     Jpeg Import Data will use the existing compressed jpeg data from the source file. If the source 

file is not a compatible jpeg file, the slide will show up as a blank red square.
●     Lossless 24 will export the image as a compressed lossless bitmap using 24-bits (about 17 

million colors).
●     Lossless 24 w/ Alpha Channel will export the image as a compressed lossless bitmap using 24-

bits (about 17 million colors) with an Alpha Channel (Transparency Data).
●     Lossless 15 will export the image as a compressed bitmap using 15-bits (32,768 colors).
●     Lossless 8 will export the image as a compressed bitmap using a 256 colormap, each represented 

by a 24-bit RGB value.

Display 

 

Show for: The number of seconds you want this slide to be displayed for before advancing to the next 
slide in the slide show. You can either use one of the preset values from the "Show For" drop down list 
or select "Custom" to enter your own value. 

Click the "Apply to all slides" button if you want to apply the duration to all slides. Click the "Apply 
to selected slides" if you want to apply the duration to all currently selected slides in the list. 



Slide Properties - Transition/Fx

The Transition/Fx tab allows you to choose an effect for how this slide will appear and an additional 
effect to display on top of the slide. 

 

Transition 



 

Transition: The drop down list will contain all of the available transition effects. 
Duration: The number of seconds the transition effect should take to complete. You can select one of 
the preset "Duration" values or select "Custom" to enter your own value. Additional settings may 
appear depending on the transition chosen. 

Click the "Apply to all slides" button if you want to apply the transition to all slides. 
Click the "Apply to selected slides" if you want to apply the transition to all currently selected slides in 
the list. 

Effect 

 

Effect: This drop down list will contain the available effects to display over the slide. 
Remove: Choose when the effect should be removed. 

●      Never: The effect will never be removed.
●      After Time: Remove the effect after a specified number of seconds has elapsed.
●      After Slide: Remove the effect after the slide this effect was displayed has finished showing.

Click the "Apply to all slides" button if you want to apply the effect to all slides. 



Click the "Apply to selected slides" if you want to apply the effect to all currently selected slides in the 
list. 



Slide Properties - Sound

The Sound tab allows you to add a sound to play during the playback of the slide. 

 

Check the "Play Sound" if you want to add a sound. Click the "Browse..." button to select a sound file 
to use. 

Properties 



 

Properties for the chosen sound will be displayed here. 

Format: The type of audio file. 
Duration: The duration length of the audio.
Sample Rate: The number of times an audio signal is sampled when it is recorded digitally. The more 
samples per second, the more accurate the digital representation of the sound. CD-quality audio has a 
sample rate of 44,100 Hz (44.1 kHz). FM radio quality audio has a sample rate of 22,050 Hz (22.05 
kHz).
Channels: Mono for 1 channel, Stereo for 2 channels. 
Sample Size: The number of bits per sample. The more bits per sample, the more accurate the digital 
representation of the sound. CD-quality audio has uses 16 bits per sample. 

Quality 

 

Quality: A list of predetermined compression settings. You may choose a preset from the list or choose 
"Custom" to choose your own settings. The presets are only recommended settings. Result may vary 
depending on the type of audio being used and it's original quality. 
Sample Rate: The number of samples per second. Higher sample rates will result in higher quality but 
larger file sizes. 
Bit Rate: The number of bits per seconds. Higher bit rates will result in higher quality but larger files 
sizes. 
Stereo: If checked the sound will be encoded in stereo, otherwise mono. Stereo will result in larger file 
sizes than Mono. 



Playback 

 

Lead-In: The number of seconds to wait before playing the sound. 
Use entire sound: If checked, the duration will be disabled and automatically filled with the actual 
duration of the source sound file. 
Duration: The number of seconds to use from the sound. The value should not exceed the actual 
duration of the sound file. This field will be filled in automatically and disabled if the "Use entire 
sound" option is checked. 
Play: Choose if you would like the audio to loop. 

●      Play Once: Play the audio once and stop.
●      Play Forever: Continually repeat the audio.
●      Loop: Repeate the audio a specified number of times and then stop.



Slide Properties - Text

The Text tab allows you to add text to the slide. 

 

Captions 



 

All the text for the page will be displayed in this list. 

Add: Adds a new text item to the list with "New" as the default text. You may change the text and it's 
properties in the "Properties" section of the Text tab.
Remove: Removes the current selected text item in the list.
Import...: Imports a Text-Osterone animated text effect. After clicking the Import button, you will be 
prompted to choose a Text-Osterone project file (.txo) that you wish to import.
Edit..: Will launch Text-Osterone to allow you to further edit the imported .txo file that was imported.

If you would like to apply the text property settings to other slides, you can use the "Apply.." drop 
down menu button. From here you may choose to "Apply settings to all slides" or "Apply settings to 
all selected slides". A dialog box should appear to choose which text settings you would like to copy 
over to the other slides.

You may also choose to duplicate specific text items to the other slides by choosing "Duplicate current 
text item to all slides" or "Duplicate current text item to selected slides". This will copy the current 
selected text item from the list to the specified slides.

Properties 

 

http://www.verticalmoon.com/products/textosterone
http://www.verticalmoon.com/products/textosterone


The properties for the currently selected caption from the list will be displayed here. Enter the text to 
display for the caption. If you would like to automatically display the filename of the source image for 
the slide, you can type in %filename. This will be replaced with the actual filename without the file 
extension of the source image when the slide show is created. For example, for a source image file 
named "vacation.jpg", the caption "My slide: %filename" would become "My slide: vacation".

Font: Click the font button to choose the Font, Style, and Size for the text.
Color: Click this button to choose a new color for the text.

Format...: Allows you set additional properties for the text.

Start Time: The number of seconds to wait before displaying the text. 
Remove: Choose when to remove the text 

●      Never: Never remove the text.
●      After Duration: Remove the text after a specified number of seconds has elapsed.
●      After Slide Duration: Remove the text after the slide has finished showing. 

Position: From this drop down list, you can choose to automatically position the text within the book, or 
choose Custom to enter in your own X and Y values.
X: The horizontal position of the text within the book.
Y: The vertical position of the text within the book.

W: The width of the area to display the text within.
H: The height of the area to display the text within.
Auto Adjust Box: If checked, the W and H will automatically be filled in to match the actual area 
needed to display the text. 



Text Format Options

The Text Format Options dialog allows you set additional settings for the text. 

 

Tracking: The number of additional pixels to add between each letter in the text.
Leading: The number of additional pixels to add between each line in the text.

Left Margin: The number of pixels to offset the text from the left side of the text box.
Right Margin: The number of pixels to offset the text from the right side of the text box.
Top Margin: The number of pixels to offset the text from the top side of the text box. 
Bottom Margin: The number of pixels to offset the text from the bottom side of the text box.

Alpha: The transparency value for the text. A value of 255 will be 100% opaque, while a value of 0 will 
be 100% transparent (invisible). 

Auto Wrap: If checked, the text will automatically wrap around to the next line if any line of text 
exceeds the width of the text box.

FX: The effect to use when displaying the text.
Out: The effect to use when removing the text. 



Slide Properties - Actions

The Actions tab allows you add actions to the slide. 

 

Mouse Click Action 

The "Mouse Click Action" options allows you to specify an action to take when the user mouse clicks 
the slide in the Flash Player. 



 

Action: The action to take when the user clicks on a slide in the slide show. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)
●      Jump to First Slide: Go to the first slide in the slide show.
●      Jump to Last Slide: Go to the last slide in the slide show.
●      Jump to Next Slide: Go to the next slide in the slide show.
●      Jump to Previous Slide: Go to the previous slide in the slide show.
●      Jump to Slide: Go to a specified slide in the slide show.
●      Print: Prints the slide

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 



the browser, outside the confiness of any frames.

Display 

The "Display" section allows you to specify what to do after a slide has finished showing.

 

Pause after this slide: Stops the slide show after the slide has finished displaying until there is user 
interaction to continue playback of the slide show. 

Action: The action to take when the slide has finished displaying. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 



which your movie resides.
●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Slide Properties - Edit

The Edit tab allows you change the appearance of the image. 

 

Image Filter 

 

Apply Image Filter: Various image filters are available to change the appearance of the image from this 
drop down list. After choosing a filter from the list, the filter dialog box will appear as shown below.



 
A preview of the image with the filter applied will be displayed. Click the "OK" button if you want to 
apply the filter to the image. Click the "Cancel" button if you do not want to apply the filter. Additional 
settings may appear depending on the filter chosen. The original image file on disk will not be changed. 
All filters will be applied when publishing the slide show file. 

Flip 

 

Click on the "Flip Horizontal" or "Flip Vertical" buttons to flip the image. 

Crop 



 

Crop: Cropping can be used if you wan to display only a certain part of the image. If checked, cropping 
will be enabled, and a crop box will appear in the preview area that you can use to set the size and 
position of the crop values. You can drag the resize the crop box in the preview area, or enter in the 
values for L/R/T/B.

Revert 

Revert: When pressed, this button will restore the image to it's original state. All image filters, flips and 
cropping that have been applied to the image will be removed. 



Slide Properties - Pan/Zoom

The Pan/Zoom tab allows you to add pans and zoom animations for the slides. 

 

Pan/Zoom List 



 

All the pan/zooms for the slide will be displayed in this list. If you want to add a new pan/zoom, click 
the "Add" button. Click the "Remove" button to remove the selected pan/zoom from the list. 

Pan/Zoom 

 

Pan X: The relative horizontal distance to pan to. A value of 0 will result in no horizontal pan. You can 
also click and drag in the preview area to set the Pan values.
Pan Y: The relative vertical distance to pan to. A value of 0 will result in no vertical pan. You can also 
click and drag in the preview area to set the Pan values.

Zoom: The absolute zoom amount from the images original size. You may also click on the "+" and 
"-" zoom buttons to increment/decrement the zoom value. A value of 100% will result in a zoom to the 
original size of the image. 

Duration: The number of seconds the Pan/Zoom should take to complete. 



Gettings Started

Below is a brief description and steps to start you to create a Album Slide Show with SWF 'n Slide. 

Add slides to the slide show 
To start using SWF 'n Slide you need to add slides to the slide show. You can add slides by browsing for 
images by selecting "Insert Slide..." from the "Slide Show" menu or dragging and dropping image files 
onto the slide list window. Click here for more information on Adding/Removing slides. 

Customize the slide show 
Use the "Slide Show Properties" dialog box to customize various properties of the slide show including 
size, sound, and text. You may bring up the "Slide Show Properties" dialog box at any time by choosing 
"Slide Show Properties..." from the Slide Show menu or the toolbar. 

Customize the slides 
After your have added your slides to the slide show, you may customize them by selecting them from the 
slide list window and opening up the "Slide Properties" dialog box. Use the "Slide Properties" dialog 
box to customize various properties for individual slides including, size, sound, text, timing, and transition 



effects. You may bring up the "Slide Properties" dialog box at any time by choosing "Slide 
Properties..." from the Slide Show menu or the toolbar. 

Preview the slide show 
When you are ready to see what your slide show will look like, you may preview the slide show by 
selecting "Preview Slide Show" from the "Slide Show" menu or the toolbar. Click here for more 
information on previewing the slide show. 

Export/Publish the slide show 
When you're ready to deliver your slide show to an audience, export or publish the slide show by 
choosing "Export..." or "Publish from the "File menu. Click here for more information on publishing 
the slide show. 

Save the slide show settings 
You can save the settings for your slide show at any time by going to the File menu and choose "Save" or 
"Save As...". A SWF 'n Slide Project File (.sns) will be saved to disk. You can then open up the project 
file by goin to the File menu and choose "Open" to continue working on your slide show. 



Add/Remove Slides

Adding Slides 

Slides may be added to the slide show by: 

●     Selecting "Insert Image(s) to Left Page..."or "Insert Image(s) to Right Page..." from the 
"Slide Show" menu. 

●     Clicking on the "Add Image to Left Page" or "Add Image to Right Page" button from the 
toolbar. 

●     Drag and drop an image file(s) onto the Slide list window. 

Supported image file types include Bitmap (bmp), GIF, JPEG, PICT, PNG, Photoshop (psd), TIFF, and 
Targa (tga).

New slides will be inserted after the last currently selected slide. If no slides are currently selected, new 



slides will be inserted at the beginning. 

Removing Slides 

Select the the slides from the list you want to remove. You may select a range of slides by holding down 
the Shift key while clicking on the slides in the list, or multiple individual slides by holding the down 
Command key. Select "Delete Slide(s)" from the "Slide Show" menu or the toolbar to remove the 
selected slides. 



Slide Show Properties - General

The General tab allows you to customize the attributes of the Flash movie and general appearance of the 
slide show. 

 

Slide Show Document



 

Document: Choose from various pre-defined standard dimensions for the slideshow, or choose Custom 
to enter in your own size. Note that larger sizes may result in decreased performance on slower 
computers.
W: The width of the slide show document. If Custom is chosen from the Document drop down list, this 
field will be enabled for you to enter in your own value, otherwise, it will be disabled automatically be 
filled in with the pre-defined value.
H: The height of the slide show document. If Custom is chosen from the Document dro down list, this 
field will be enabled for you to enter in your own value, otherwise, it will be disabled automatically be 
filled in with the pre-defined value.

Frame Rate: The number of frames per second to play the slide show at. Higher frame rates will result 
in smoother animation, but may result in decreased performance on slower computers. Common frame 
rates are as follows: 

●     Web - 8 to 15 fps 
●     Standard Motion Picture - 24 fps 
●     NTSC - 29.97 fps 
●     PAL - 25 fps 

Bg Color: Click to choose the color to display in the background of the slide show document.
Bg Image: Check this option if you would like to display an image in the background. If checked, the 
Settings.. button will be enabled for you to set the properties for the background image.

Compress: If checked, the exported .swf file will be compressed. To playback compressed .swf files, 
the viewer will need version 6 or higher of the Flash Player.
Protect: If checked, Macromedia's Flash Authoring Tool will not be able to import the export .swf file.
Disable Printing: If checked, the Print option from the Flash player will be disabled. 

Album 



 

W: The width of the book.
H: The height of the book.
Match Document: If checked, the W and H will be disabled and automatically be filled to match the 
size of the slide show album document.
Page Size: The size of each page will be displayed based upon the dimensions of the book.

X: The horizontal position of the book within the slide show document.
Y: The vertical position of the book within the slide show document.
Align: Choose to automatically position the book with the document, or choose Custom to enter in your 
own position.



Slide Show Properties - SWF

The SWF tab allows you to customize the playback of the slide show. 

 

Movie Start Action 

The "Movie Start Action" option allows you to choose an action when the slide show starts. 



 

Play Automatically: Start playing the slide show as soon as it is loaded into the Macromedia Flash 
Player. 
Play after Pause: Start playing the slide show after the desired number of seconds has elapsed. 
Stop on First Frame: Load the slide show into the Macromedia Flash Player and then stop until there is 
user interaction to continue playing the slide show. One method to resume playback when this option is 
chosen is to target the slide show SWF from an external SWF and resume playback via actionscript. You 
may also right click ( Control + click) to bring up the Flash popup menu and select "Play" to resume 
playback of the slide show. 

Preload: Allows you to add a preloader to the slide show. If this option is chosen, a progress bar will be 
displayed showing the percentage of the slide show that has been downloaded/loaded into the 
Macromedia Flash Player. When the desired percentage of the SWF file has been loaded, playback of 
the slide show will begin. This option is helpful to allow smoother playback on slower internet 
connections. Click the Settings.. button to customize the preloader.

Mouse Click Action 

The "Mouse Click Action" option allows you to specify an action to take when the user mouse clicks 
the Macromedia Flash Player while the slide show is playing. 

Action: The action to take when the user mouse clicks on the slide show. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)



Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Slide Show Properties - Sound

The Sound tab allows you to add a sound to play during the playback of the slide show. 

 

Check the "Play Sound" if you want to add a sound. Click the "Browse..." button to select a sound file 
to use. 

Properties 



 

Properties for the chosen sound will be displayed here. 

Format: The type of audio file. 
Duration: The duration length of the audio.
Sample Rate: The number of times an audio signal is sampled when it is recorded digitally. The more 
samples per second, the more accurate the digital representation of the sound. CD-quality audio has a 
sample rate of 44,100 Hz (44.1 kHz). FM radio quality audio has a sample rate of 22,050 Hz (22.05 
kHz).
Channels: Mono for 1 channel, Stereo for 2 channels. 
Sample Size: The number of bits per sample. The more bits per sample, the more accurate the digital 
representation of the sound. CD-quality audio has uses 16 bits per sample. 

Quality 

 

Quality: A list of predetermined compression settings. You may choose a preset from the list or choose 
"Custom" to choose your own settings. The presets are only recommended settings. Result may vary 
depending on the type of audio being used and it's original quality. 
Sample Rate: The number of samples per second. Higher sample rates will result in higher quality but 
larger file sizes. 
Bit Rate: The number of bits per seconds. Higher bit rates will result in higher quality but larger files 
sizes. 
Stereo: If checked the sound will be encoded in stereo, otherwise mono. Stereo will result in larger file 



sizes than Mono. 

Playback 

 

Lead-In: The number of seconds to wait before playing the sound. 
Use entire sound: If checked, the duration will be disabled and automatically filled with the actual 
duration of the source sound file. 
Duration: The number of seconds to use from the sound. The value should not exceed the actual 
duration of the sound file. This field will be filled in automatically and disabled if the "Use entire 
sound" option is checked. 
Play: Choose if you would like the audio to loop. 

●      Play Once: Play the audio once and stop.
●      Play Forever: Continually repeat the audio.
●      Loop: Repeate the audio a specified number of times and then stop.

Stream: If checked, the audio will stream in. 



Slide Properties - Media

The Media tab allows you to set how the media will be displayed within the pages of the slide show 
album book. 

 

Media 



 

Path: Displays the current full path to the source file for the media.
Dimensions: The dimensions of the source media (if any) in pixels.

Browse: Click the Browse button to choose a new source file for the media.

Output 

 

Place On: Choose which page the media will be displayed on. You can choose whether you want the 
media to be displayed on the Left Page, Right Page, or Both Pages. The page you choose to display the 
media on will also determine where the media will be automatically aligned and scaled to fit, if these 
options are enabled.

X: The horizontal position of the media relative to the left side of the book. 
Y: The vertical position of the media relative to the top side of the book.
Align Image: If checked, the media can be automatically positioned within the page(s) it is placed on. If 
checked, the 6 alignment buttons will be enabled. You can choose from the 3 horizontal alignment 
positions (left/center/right) and from the 3 vertical alignment positions (top/center/bottom).

W: The output width of the media in pixels.
H: The output height of the media in pixels.
Scale To Fit: If checked, the output size of the media will be stretched to fit the dimensions of the page. 
The output dimensions will automatically be filled in, and cannot be changed unless unchecked again.



Keep Aspect Ratio: If checked, the media will retain it's original proportions when changing the output 
width or height of the media.

Rotate: The angle at which to display the the media in the page.

Export: The output format for the media. If Jpeg or Jpeg w/ Alpha Channel is chosen, you will need to 
set the Quality. The Quality can be a value ranging from 1 to 100 where 100 will result in the highest 
image quality and the largest file sizes, while a value of 1 will result in the lowest quality and smallest 
file sizes. 

●     Jpeg will compress the images to jpeg.
●     Jpeg w/ Alpha Channel will compress the images to jpeg with an Alpha Channel (Tranparency 

Data).
●     Jpeg Import Data will use the existing compressed jpeg data from the source file. If the source 

file is not a compatible jpeg file, the slide will show up as a blank red square.
●     Lossless 24 will export the image as a compressed lossless bitmap using 24-bits (about 17 

million colors).
●     Lossless 24 w/ Alpha Channel will export the image as a compressed lossless bitmap using 24-

bits (about 17 million colors) with an Alpha Channel (Transparency Data).
●     Lossless 15 will export the image as a compressed bitmap using 15-bits (32,768 colors).
●     Lossless 8 will export the image as a compressed bitmap using a 256 colormap, each represented 

by a 24-bit RGB value.



Slide Properties - Actions

The Actions tab allows you specify an action to take when the user mouse clicks on a slide.

 

Mouse Click Action 



 

Action: The action to take when the user mouse clicks on the slide. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)
●      Print: Prints the slide

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Slide Properties - Edit

The Edit tab allows you change the appearance of an image. 

 

Image Filter 

 

Apply Image Filter: Various image filters are available to change the appearance of the image from this 
drop down list. After choosing a filter from the list, the filter dialog box will appear as shown below.



 
A preview of the image with the filter applied will be displayed. Click the "OK" button if you want to 
apply the filter to the image. Click the "Cancel" button if you do not want to apply the filter. Additional 
settings may appear depending on the filter chosen. The original image file on disk will not be changed. 
All filters will be applied when publishing the slide show file. 

Flip 

 

Click on the "Flip Horizontal" or "Flip Vertical" buttons to flip the image. 

Crop 



 

Crop: Cropping can be used if you wan to display only a certain part of the image. If checked, cropping 
will be enabled, and a crop box will appear in the preview area that you can use to set the size and 
position of the crop values. You can drag the resize the crop box in the preview area, or enter in the 
values for L/R/T/B.

Revert 

Revert: When pressed, this button will restore the image to it's original state. All image filters, flips and 
cropping that have been applied to the image will be removed. 



Slide Properties - Page

The Page tab allows you to set the properties of the pages within the slide show album.

 

Left Page 



 

Type: Choose the page type for the left page from the drop down list. 

●      Paper - The page will behave like a paperback magazine/book.
●      Hard - The page will be stiff/hard when flipping the page. This behaves like a hard cover book.
●      Tear - The page behaves like the Paper page, but can be torn off while flipping the page.

Bg Color: The background color of the left page. Click the color button to choose a different color for 
the page.

Right Page 

 

Type: Choose the page type for the right page from the drop down list. 

●      Paper - The page will behave like a paperback magazine/book.
●      Hard - The page will be stiff/hard when flipping the page. This behaves like a hard cover book.
●      Tear - The page behaves like the Paper page, but can be torn off while flipping the page.

Bg Color: The background color of the right page. Click the color button to choose a different color for 
the page. 

Auto Flip: If checked, the right page will flip to the next page automatically after the specified number 
of seconds has elapsed. If unchecked, the pages will only advance via user interaction. 



Slide Properties - Text

The Text tab allows you to add text to a page in the album slide show. 

 

Captions 



 

All the text for the page will be displayed in this list. 

Add: Adds a new text item to the list with "New" as the default text. You may change the text and it's 
properties in the "Properties" section of the Text tab.
Remove: Removes the current selected text item in the list.
Import...: Imports a Text-Osterone animated text effect. After clicking the Import button, you will be 
prompted to choose a Text-Osterone project file (.txo) that you wish to import.
Edit..: Will launch Text-Osterone to allow you to further edit the imported .txo file that was imported.

If you would like to apply the text property settings to other slides, you can use the "Apply.." drop 
down menu button. From here you may choose to "Apply settings to all slides" or "Apply settings to 
all selected slides". A dialog box should appear to choose which text settings you would like to copy 
over to the other slides.

You may also choose to duplicate specific text items to the other slides by choosing "Duplicate current 
text item to all slides" or "Duplicate current text item to selected slides". This will copy the current 
selected text item from the list to the specified slides.

Text Properties 

The properties for the currently selected text item from the list will be displayed in this section of the 
Text tab.

http://www.verticalmoon.com/products/textosterone
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Font: Click the font button to choose the Font, Style, and Size for the text.
Color: Click this button to choose a new color for the text.

Format...: Allows you set additional properties for the text.

Place On: Choose from the drop down list which page(s) you wish the text to be displayed on. You can 
choose the Left Page, Right Page, or Both Pages.

Position: From this drop down list, you can choose to automatically position the text within the book, or 
choose Custom to enter in your own X and Y values.
X: The horizontal position of the text within the book.
Y: The vertical position of the text within the book.

W: The width of the area to display the text within.
H: The height of the area to display the text within.
Auto Adjust Box: If checked, the W and H will automatically be filled in to match the actual area 
needed to display the text.



Gettings Started

Below is a brief description and steps to start you to create a Scrolling Slide Show with SWF 'n Slide. 

Add slides to the slide show 
To start using SWF 'n Slide you need to add slides to the slide show. You can add slides by browsing for 
images by selecting "Insert Slide..." from the "Slide Show" menu or dragging and dropping image files 
onto the slide list window. Click here for more information on Adding/Removing slides. 

Customize the slide show 
Use the "Slide Show Properties" dialog box to customize various properties of the slide show including 
size, sound, and text. You may bring up the "Slide Show Properties" dialog box at any time by choosing 
"Slide Show Properties..." from the Slide Show menu or the toolbar. 

Customize the slides 
After your have added your slides to the slide show, you may customize them by selecting them from the 
slide list window and opening up the "Slide Properties" dialog box. Use the "Slide Properties" dialog 
box to customize various properties for individual slides including, size, sound, text, timing, and transition 



effects. You may bring up the "Slide Properties" dialog box at any time by choosing "Slide 
Properties..." from the Slide Show menu or the toolbar. 

Preview the slide show 
When you are ready to see what your slide show will look like, you may preview the slide show by 
selecting "Preview Slide Show" from the "Slide Show" menu or the toolbar. Click here for more 
information on previewing the slide show. 

Export/Publish the slide show 
When you're ready to deliver your slide show to an audience, export or publish the slide show by 
choosing "Export..." or "Publish from the "File menu. Click here for more information on publishing 
the slide show. 

Save the slide show settings 
You can save the settings for your slide show at any time by going to the File menu and choose "Save" or 
"Save As...". A SWF 'n Slide Project File (.sns) will be saved to disk. You can then open up the project 
file by goin to the File menu and choose "Open" to continue working on your slide show. 



Add/Remove Slides

Adding Slides 

Slides may be added to the slide show by: 

●     Selecting "Insert Slide..." from the "Slide Show" menu. 
●     Selecting "Insert Folder..." from the "Slide Show" menu. 
●     Clicking on the "Insert Slide" button from the toolbar. 
●     Drag and drop an image file(s) onto the Slide list window. 

Supported image file types include Bitmap (bmp), GIF, JPEG, PICT, PNG, Photoshop (psd), TIFF, and 
Targa (tga).

New slides will be inserted after the last currently selected slide. If no slides are currently selected, new 
slides will be inserted at the beginning. 

Removing Slides 



Select the the slides from the list you want to remove. You may select a range of slides by holding down 
the Shift key while clicking on the slides in the list, or multiple individual slides by holding the down 
Command key. Select "Delete Slide(s)" from the "Slide Show" menu or the toolbar to remove the 
selected slides. 



Slide Show Properties - General

The General tab allows you to customize the attributes of the Flash movie and general appearance of the 
slide show. 

 

Slide Show 



 

Document: Choose from various pre-defined standard dimensions for the slideshow, or choose Custom 
to enter in your own size. Note that larger sizes may result in decreased performance on slower 
computers.
W: The width of the slide show document. If Custom is chosen from the Document drop down list, this 
field will be enabled for you to enter in your own value, otherwise, it will be disabled automatically be 
filled in with the pre-defined value.
H: The height of the slide show document. If Custom is chosen from the Document dro down list, this 
field will be enabled for you to enter in your own value, otherwise, it will be disabled automatically be 
filled in with the pre-defined value.

Frame Rate: The number of frames per second to play the slide show at. Higher frame rates will result 
in smoother animation, but may result in decreased performance on slower computers. Common frame 
rates are as follows: 

●     Web - 8 to 15 fps 
●     Standard Motion Picture - 24 fps 
●     NTSC - 29.97 fps 
●     PAL - 25 fps 

Bg Color: Click to choose the color to display in the background of the slide show document.
Bg Image: Check this option if you would like to display an image in the background. If checked, the 
Settings.. button will be enabled for you to set the properties for the background image.

Compress: If checked, the exported .swf file will be compressed. To playback compressed .swf files, 
the viewer will need version 6 or higher of the Flash Player.
Protect: If checked, Macromedia's Flash Authoring Tool will not be able to import the export .swf file.
Disable Printing: If checked, the Print option from the Flash player will be disabled.



Slide Show Properties - Strip

The Strip tab allows you to set the properties for the scrolling strip in the slide show. 

 

Scrolling Slide Show 



 

W: The width of the scrolling strip.
H: The height of the scrolling strip.
Match Document: If checked, the Width and Height will automatically be disabled and filled in the the 
dimensions of the slide show document.

X: The horizontal position of the scrolling strip.
Y: The vertical position of the scrolling strip.
Align: Choose to have the scrolling strip automatically aligned within the slide show document, or 
choose Custom to enter in your own position.

Border: If checked, a line border will be added to each image in the scrolling strip. Click the color 
button to choose a color for the border line.
Offset: The number of pixels to offset the border line from the edge of each image in the slide show.

Direction: Choose which direction the image in the strip should scroll.
Speed: The speed at which the images will scroll in the strip.
Slide Space: The number of pixels to add between each image in the strip.

Type: The behaviour of the scrolling. 

●      Stop: Stops scrolling when the last image in the strip is reached.
●      Loop: Continually scrolls forever.
●      Reverse: Reverses scrolling direction when the first/last image in the strip is reached.

Mouse Control: If checked, the scrolling direction and speed can be controlled by moving the mouse 
cursor over the strip.
Stop Scrolling On Mouse Out: If checked, the strip will stop scrolling once the mouse is no longer over 
the strip.



Mouse Over 

 

Mouse Over: Check this option if you wish to change the appearance of the slide that the mouse cursor 
is over in the scrolling slide show.

Type: Choose from the drop down list to change the appearance of the slide that the mouse cursor is 
over. 

●     None: No change
●     Hilite: Hilites the slide that the mouse cursor is over
●     Un-Hilite: Hilites the slides that the mouse cursor is not over
●     Alpha: Adds a transparency to the slide that the mouse cursor is over
●     Un-Alpha: Adds a transparency to the slides that the mouse cursor is not over 

Border: If checked, a line border will be displayed around the slide that the mouse cursor is over.
Choose the color of the line by clicking the color button.
H: The horizontal offset of the line border from the edge of the slide.
V: The vertical offset of the line border from the edge of the slide. 



Slide Show Properties - Target

The Target tab allows you to set the properties for the area to load the full size version of each slide.

 

Target View 



 

Target View: If checked, an area within the slide show to load a full size of the current thumbnail from 
the scrolling strip will be added to the slide show document. 

W: The width of the Target View.
H: The height of the Target View.
Match Document: If checked, the Width and Height fields will automatically be filled with the 
dimensions of the slide show document and will be disabled.

X: The horizontal position of the Target View.
Y: The vertical position of the Target View.
Align: Choose to have the Target View automatically aligned within the slide show document, or choose 
Custom to enter in your own position.

FX & Load External 

 

FX: Choose the type of transition effect you wish to use in the Target View.

Load External: If not checked, each full size slide is embedded within slide show exported file. If 
checked, each full size slide will be loaded from an external file. Each slide will be exported to a new .
swf file, numbered 1.swf to n.swf where n is the maximum number of slides in the scrolling strip.
External Output Folder: The folder where the external .swf files are saved to.



Preload: If checked, a preloader will be added to each external .swf file. Click the Settings... button to 
change the settings for the preloader. 



Slide Show Properties - SWF

The SWF tab allows you to customize the playback of the slide show. 

 

Movie Start Action 

The "Movie Start Action" option allows you to choose an action when the slide show starts. 



 

Play Automatically: Start playing the slide show as soon as it is loaded into the Macromedia Flash 
Player. 
Play after Pause: Start playing the slide show after the desired number of seconds has elapsed. 
Stop on First Frame: Load the slide show into the Macromedia Flash Player and then stop until there is 
user interaction to continue playing the slide show. One method to resume playback when this option is 
chosen is to target the slide show SWF from an external SWF and resume playback via actionscript. You 
may also right click ( Control + click) to bring up the Flash popup menu and select "Play" to resume 
playback of the slide show. 

Preload: Allows you to add a preloader to the slide show. If this option is chosen, a progress bar will be 
displayed showing the percentage of the slide show that has been downloaded/loaded into the 
Macromedia Flash Player. When the desired percentage of the SWF file has been loaded, playback of 
the slide show will begin. This option is helpful to allow smoother playback on slower internet 
connections. Click the Settings.. button to customize the preloader. 

Mouse Click Action 

The "Mouse Click Action" option allows you to specify an action to take when the user mouse clicks 
the Macromedia Flash Player while the slide show is playing. 

Action: The action to take when the user mouse clicks on the slide show. 

●      None: No action to take.



●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Slide Show Properties - Sound

The Sound tab allows you to add a sound to play during the playback of the slide show. 

 

Check the "Play Sound" if you want to add a sound. Click the "Browse..." button to select a sound file 
to use. 

Properties 



 

Properties for the chosen sound will be displayed here. 

Format: The type of audio file. 
Duration: The duration length of the audio.
Sample Rate: The number of times an audio signal is sampled when it is recorded digitally. The more 
samples per second, the more accurate the digital representation of the sound. CD-quality audio has a 
sample rate of 44,100 Hz (44.1 kHz). FM radio quality audio has a sample rate of 22,050 Hz (22.05 
kHz).
Channels: Mono for 1 channel, Stereo for 2 channels. 
Sample Size: The number of bits per sample. The more bits per sample, the more accurate the digital 
representation of the sound. CD-quality audio has uses 16 bits per sample. 

Quality 

 

Quality: A list of predetermined compression settings. You may choose a preset from the list or choose 
"Custom" to choose your own settings. The presets are only recommended settings. Result may vary 
depending on the type of audio being used and it's original quality. 
Sample Rate: The number of samples per second. Higher sample rates will result in higher quality but 
larger file sizes. 
Bit Rate: The number of bits per seconds. Higher bit rates will result in higher quality but larger files 
sizes. 
Stereo: If checked the sound will be encoded in stereo, otherwise mono. Stereo will result in larger file 



sizes than Mono. 
|

Playback 

 

Lead-In: The number of seconds to wait before playing the sound. 
Use entire sound: If checked, the duration will be disabled and automatically filled with the actual 
duration of the source sound file. 
Duration: The number of seconds to use from the sound. The value should not exceed the actual 
duration of the sound file. This field will be filled in automatically and disabled if the "Use entire 
sound" option is checked. 
Play: Choose if you would like the audio to loop. 

●      Play Once: Play the audio once and stop.
●      Play Forever: Continually repeat the audio.
●      Loop: Repeate the audio a specified number of times and then stop.

Stream: If checked, the audio will stream in. 



Slide Properties - Meda

The Media tab allows you to set how the media will be displayed. 

 

Media 



 

Path: Displays the current full path to the source file for the media.
Dimensions: The dimensions of the source media (if any) in pixels.

Browse: Click the Browse button to choose a new source file for the media.

Output 

 

Export: The output format for the media. If Jpeg or Jpeg w/ Alpha Channel is chosen, you will need to 
set the Quality. The Quality can be a value ranging from 1 to 100 where 100 will result in the highest 
image quality and the largest file sizes, while a value of 1 will result in the lowest quality and smallest 
file sizes. 

●     Jpeg will compress the images to jpeg.
●     Jpeg w/ Alpha Channel will compress the images to jpeg with an Alpha Channel (Tranparency 

Data).
●     Jpeg Import Data will use the existing compressed jpeg data from the source file. If the source 

file is not a compatible jpeg file, the slide will show up as a blank red square.
●     Lossless 24 will export the image as a compressed lossless bitmap using 24-bits (about 17 

million colors).
●     Lossless 24 w/ Alpha Channel will export the image as a compressed lossless bitmap using 24-

bits (about 17 million colors) with an Alpha Channel (Transparency Data).
●     Lossless 15 will export the image as a compressed bitmap using 15-bits (32,768 colors).
●     Lossless 8 will export the image as a compressed bitmap using a 256 colormap, each represented 

by a 24-bit RGB value.



Slide Properties - Actions

The Actions tab allows you add actions to the slide. 

 

Mouse Click Action 

The "Mouse Click Action" options allows you to specify an action to take when the user mouse clicks 
on a slide in the scrolling slide show. 



 

Action: The action to take when the user clicks on a slide in the scrolling slide show strip. 

●      None: No action to take.
●      Get URL: Loads a standard URL (eg. http://www.verticalmoon.com)
●      Load SWF: Loads an external SWF file (eg. another.swf)
●      Load Thumbnail: Loads a full size of the slide into the Target View area 
●      Print: Prints the slide

Target: If the Action is Get URL or Load SWF, you can specify the target to load the URL/SWF to. 

●      Custom: Specify your own target
●      Pop-Up Window: Loads the URL/Path to a pop-up window. When choosing this option a 

Settings... button will appear to customize the Pop-Up Window Settings. For the pop up window 
to work properly you will either need to export both the .swf and .html files from the "Publish 
Settings..." or add the following javascript code to your html file that displays the .swf file 
between the <HEAD> and </HEAD> tags.
<SCRIPT language="JavaScript">
function VM_Popup(theURL, winName, winFeatures) {newWin=window.open(theURL, 
winName, winFeatures); }
</SCRIPT> 

●      _blank: Creates a new browser window and loads the URL/Path into it.
●      _parent: Removes the current frameset and loads the URL/Path in its place. Use this option if 

you have multiple nested framesets, and you want your URL to replace only the frameset in 
which your movie resides.

●      _self: Loads the URL/Path into the same frame or window as the current movie. 
●      _top: Loads the URL/Path into the current browser and removes all framesets in the process. 

Use this option if your movie is in a frame, but you want your linked URL to load normally into 
the browser, outside the confiness of any frames.



Slide Properties - Edit

The Edit tab allows you change the appearance of the image. 

 

Image Filter 

 

Apply Image Filter: Various image filters are available to change the appearance of the image from this 
drop down list. After choosing a filter from the list, the filter dialog box will appear as shown below.



 
A preview of the image with the filter applied will be displayed. Click the "OK" button if you want to 
apply the filter to the image. Click the "Cancel" button if you do not want to apply the filter. Additional 
settings may appear depending on the filter chosen. The original image file on disk will not be changed. 
All filters will be applied when publishing the slide show file. 

Flip 

 

Click on the "Flip Horizontal" or "Flip Vertical" buttons to flip the image. 

Crop 



 

Crop: Cropping can be used if you wan to display only a certain part of the image. If checked, cropping 
will be enabled, and a crop box will appear in the preview area that you can use to set the size and 
position of the crop values. You can drag the resize the crop box in the preview area, or enter in the 
values for L/R/T/B.

Revert 

Revert: When pressed, this button will restore the image to it's original state. All image filters, flips and 
cropping that have been applied to the image will be removed. 



Slide Properties - Text

The Text tab allows you to add text to the slide. 

 

Captions 



 

All the text for the page will be displayed in this list. 

Add: Adds a new text item to the list with "New" as the default text. You may change the text and it's 
properties in the "Properties" section of the Text tab.
Remove: Removes the current selected text item in the list.
Import...: Imports a Text-Osterone animated text effect. After clicking the Import button, you will be 
prompted to choose a Text-Osterone project file (.txo) that you wish to import.
Edit..: Will launch Text-Osterone to allow you to further edit the imported .txo file that was imported.

If you would like to apply the text property settings to other slides, you can use the "Apply.." drop 
down menu button. From here you may choose to "Apply settings to all slides" or "Apply settings to 
all selected slides". A dialog box should appear to choose which text settings you would like to copy 
over to the other slides.

You may also choose to duplicate specific text items to the other slides by choosing "Duplicate current 
text item to all slides" or "Duplicate current text item to selected slides". This will copy the current 
selected text item from the list to the specified slides.

Properties 

 

http://www.verticalmoon.com/products/textosterone
http://www.verticalmoon.com/products/textosterone


Font: Click the font button to choose the Font, Style, and Size for the text.
Color: Click this button to choose a new color for the text.

Format...: Allows you set additional properties for the text.

Position: From this drop down list, you can choose to automatically position the text within the slide 
show document, or choose Custom to enter in your own X and Y values.
X: The horizontal position of the text within the slide show document.
Y: The vertical position of the text within the slide show document.

W: The width of the area to display the text within.
H: The height of the area to display the text within.
Auto Adjust Box: If checked, the W and H will automatically be filled in to match the actual area 
needed to display the text. 



Frequently Asked Questions

What is a SWF file? 

The Macromedia Flash file format (SWF) (pronounced "swiff") delivers vector graphics and 
animation over the Internet to the Macromedia Flash Player. 

What platforms are supported for Macromedia Flash playback? 

Macintosh OS 9.x, OS 10.x
Windows 98, ME, 2000, 
XP 

How many people have the Macromedia Flash Player installed? 

The Macromedia Flash Player is the world's most pervasive software platform, used by over 1 
million professionals and reaches more than 97% of Internet-enabled desktops worldwide as well as 
a wide range of devices. 

SWF 'n Slide won't run or start up. 

If running Macintosh OS 9.x try the following:

●     Reboot the computer with only the base extension set enabled. One or more of the extensions 
in the System Folder may be causing a conflict with SWF 'n Slide. 

●     Allocate more memory to the program. 
●     Update your OS, CarbonLib extension, QuickTime to the latest versions. 

What version of the Flash Player are the SWF file exported from SWF 'n Slide compatible with? 

SWF 'n Slide creates SWF files that are compatible with the Flash Player version 5 and up. If you 
are publishing Projector files, the Flash Player is not needed since the player is already a part of 
the Projector file. 

I use two computers (home and office). Can I install my software on both computers? 



You are entitled to a License for installing the software at home and work, provided they are not 
both used at the same time, or by more than one person. However, you will need to generate 
separate Activation Codes for each installation of the program. 

How do I obtain an Activation Code? 

Please visit http://www.verticalmoon.com/register and follow the instructions on the 
page. 

http://www.verticalmoon.com/register


Contact Us

E-mail: 
support@verticalmoon.com 

Web: 
http://www.verticalmoon.com/support 

mailto:support@verticalmoon.com
http://www.verticalmoon.com/support
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